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1) Download all the OptiPlant ZIP folder from 
https://github.com/njbca/OptiPlant

2) Modify/tune the parameters found in the Base > Data               folder:  

Techno-ecnomical data (‘Inputs’)

Wind/solar profiles and electricity prices (‘Profiles’)

-more info here-

-more info here-

3) Install the necessary software: Julia, VSCode and add the 
necessary packages (JuMP, HiGHS, XLSX, DataFrames and CSV)

Open the Main.jl Julia file found in the Run Code folder.
Edit the code if necessary. Run the code file

-more info here-

-more info here-

4) Check the obtained outcomes (CSV) in the defined drectory

inside the Base > Results folder

Import the CSV data to the ‘Results’ excel file found in the same folder 

to process and visualize the model outcomes

-more info here-

-(Extended and detailed instructions to install all the software and to run OptiPlant tool are presented in the next slides of this document)-

https://github.com/njbca/OptiPlant
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The OptiPlant model is designed in such a way that the input parameters, the optimization objective, variables or constrains, and the

outcoming results can be modified in a fairly easy way. The solving time on a personal computer is usually below 5 minutes using an open-

source solver.

For a more detailed description of the OptiPlant model such as the components and structure of the simulated plant, the mathematical

description of the optimization model, the sources of the data inputs or other considerations, one can check the following article:

Nicolas Campion et al. “Techno-economic assessment of green ammonia production with different wind and solar potentials”. English.

In: Renewable Sustainable Energy Reviews 173 (2023). issn: 1364-0321. doi: 10.1016/j.rser. 2022.113057.

https://www.sciencedirect.com/science/article/pii/S1364032122009388
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OptiPlant is a linear optimization model that minimize the investment and operation costs of a power-to-X system that can be powered with

wind, solar and the grid

All the documentation regarding OptiPlant (including this guide) and the tool itself can be downloaded directly from the website

https://github.com/njbca/OptiPlant and clicking on <> Code => Download ZIP

As stated on the README.md file, the purpose of this document is to provide detailed user guide to correctly run and interpret the outcomes

of the OptiPlant tool.
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[Fig.1]

https://github.com/njbca/OptiPlant


OptiPlant is a tool developed by Nicolas Campion from the DTU Department of Technology, Management and Economics that enables the user

to model Power-to-X fuel production systems with a high variety of customizable input parameters and to optimize them according to different

criteria. The model works under the ‘dynamic power supply and system optimization’ approach (DPS-Syst-Opt).

The fuel plant is modelled using a linear deterministic programming model which aims to minimize the fuel production cost of a PtX plant by

managing the investments and operation of storage, power-supply and fuel production units under certain constraints. It assumes perfect

foresight.

The yearly fuel demand is the main driver of the model, meaning that the model would minimize the fuel production costs of the PtX plant as

long as the yearly fuel demand is fulfilled.
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The system’s optimization model has the following specifications:

• The model input parameters are: the techno-economic data of the

different units, the hourly grid electricity prices, the hourly

renewable power production profiles and the by-product market

prices.

• The goal or objective of this model is to minimize the annualized

system cost of the PtX power plant, using as variables the invested

capacities and the hourly mass/energy flows. The system is

constrained by a minimum fuel production quantity, the min/max

load of the different units and the mass/energy balances between

the different units.

• The outcomes or results of the model are the fuel production cost,

the sizing of the different units of the system and the operation of

the system (in terms of mass and energy flows).
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[Fig.2]
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In the following slides, an installation guide for all the necessary software to run OptiPlant is provided. All the needed software programs are

listed below:

• Julia: The programming language that we are going to use to formulate the optimization problems. For download and documentation, visit

https://julialang.org/.

• Visual Studio Code: An editor for writing and executing your Julia code. For download and documentation, go to the link

https://code.visualstudio.com/. (You are welcome to work with any other editor of your choice, for example: Jupyter notebook or Atom).

• JuMP: A package embedded in the Julia programming language. It allows users to write optimization problems. For documentation, see

https://jump.dev/JuMP.jl/stable/.

• HiGHS: An open-source high performance solver for linear programming problems (LP). For documentation, go to the page

https://highs.dev/. Alternatively, the commercial soler Gurobi can also be used.

• The installation guide of other necessary specific packages to read and clean data, visualize and plot results, etc. is also provided in this 

document.
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https://julialang.org/
https://code.visualstudio.com/
https://jump.dev/JuMP.jl/stable/
https://highs.dev/


All the items mentioned in the previous slide work together as follows: 

An optimization problem is written in the Julia programming language, using the JuMP package syntax and VS-Code as a text editor. Various

data is imported from CSV or excel files using specific packages. Then, all the info is passed to the solver HiGHS (other solvers can also be

used), which finds an optimal solution to the problem by using a variety of optimization approaches and techniques. Finally, the obtained

results can be exported as CSV files or plotted in graphs using other specific packages.

Installation guidance for each of these software can be found in the following slides.
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Julia is a high-level, general-purpose, dynamic programming language. Its features are well suited for numerical analysis and computational
science

Installation steps:
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1) Go to: https://julialang.org/downloads/ and download the Julia version corresponding to your operating system.

[Fig.3]

https://julialang.org/downloads/


Installation steps:
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2) Run the Julia installer and install the program:

Tick the box ‘Add Julia 

to PATH’ only if you 

already have Visual 

Studio Code already 

installed on your PC

[Fig.4]



Installation steps:
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3) If the installation is successful, this message will appear: 

You just got Julia on 
your PC!

[Fig.5]



Visual Studio Code is a lightweight but powerful source code editor which runs on your desktop and is available for Windows, macOS and
Linux.

Installation steps:
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1) Go to the website: https://code.visualstudio.com/Download and download the version corresponding to your operating system.

[Fig.6]

https://code.visualstudio.com/Download


Installation steps:
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2) Run the Visual Studio Code installer and install the program

[Fig.7]



Installation steps:
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IMPORTANT NOTE: During the installation process, remember to tick the option ‘Add to PATH (requires shell restart)’:

[Fig.8]



Installation steps:
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3) If the installation is successful, this message will appear: 

You just got VS Code on your
PC! Next step is to add the
corresponding extensions and
save them in an ‘environment’.

[Fig.9]



In order to be able to run the OptiPlant model in Visual Studio Code, several extensions and packages need to be installed.

Julia extension
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Provides support for the Julia programming language in the VS Code editor. To install it, open VS Code and go to ‘View > Extensions’ or click in

the fifth icon on the left. Type ‘Julia’ and install the extension.

>Extensions

[Fig.10]



Julia extension
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For more information such as a ‘start-up’ guide for Julia in VSCode, go to: https://code.visualstudio.com/docs/languages/julia

To start Julia in visual code, press ‘Ctrl+Shift+P’ (it opens the Command Palette) and type he command: ’Start Julia’. After, you can start coding

with Julia (e.g. 1 + 1 = 2):

This installed extension provides a Julia REPL 
(console) inside VS Code. Start the terminal 
at the beginning of every session by writing 
“Julia: Start REPL” in the  command palette. 

[Fig.11]

https://code.visualstudio.com/docs/languages/julia


Other packages (‘Package manager’)
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The package manager lets you install, update and remove packages. To enter the ‘package manager’ press ‘]’ (you will see that the colored text

‘julia>’ text changes to ‘(@v1.8) pkg>’.

*(You can go back by just pressing the backspace button)

Activate the environment by writing ‘activate env’ on the package manager (you can see it is activated as the name ‘(@v1.8) pkg>’ will change

to ‘(env) pkg>’). This creates a new environment/folder called env:

[Fig.12]



Other packages (‘Package manager’)
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The packages required to run ‘OptiPlant’ are: JuMP (allows writing optimization problems in Julia), HiGHS or Gurobi (LP solvers), DataFrames

(enables working with structured data), CSV (reads CSV files) and XLSX (reads excel files in .xlsx format).

The installation of these packages is quite easy: After activating the
environment (env), write the following command in the terminal:
‘add ***’ (***= name of the package) and press enter. The
installation of the packages will start automatically, and they will be
saved inside the ‘env’ folder.

The check that all packages have been correctly installed, write the
command ‘status’ in the terminal -inside the env- and press enter.

Some other extra packages that would enable the plotting and visualization of the results are: Plots, StatsPlots or PrettyTables. They can be
installed the same way as described above.

[Fig.13]
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Although HiGHS is the recommended solver to be used with OptiPlant -as it is open-source-, Gurobi is a faster -but commercial- alternative.

Only one solver is required to run the OptiPlant tool, and both provide the same results.

To install and use Gurobi, one needs to get a using license first. To get that, go to https://www.gurobi.com/ in ‘Downloads & Licenses’ and

register yourself as a user. Once you are registered, get the license that better suits you.

After generating the license, you will get a grbgetkey, it is important you copy this safely, as it is crucial during the installation of Gurobi

Afterwards, go to https://www.gurobi.com/downloads/gurobi-optimizer-eula/ and install the latest version of Gurobi optimizer.

*OPTIONAL

https://www.gurobi.com/
https://www.gurobi.com/downloads/gurobi-optimizer-eula/
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Open the Gurobi installer and follow the instructions. Once Gurobi is installed restart your system manually (if it is not done automatically after

its installation).

Next, open the ‘Command Prompt’ of your system –write “cmd” in the search menu of your PC- and insert the grbgetkey you have previously

saved “grbgetkey *n*u*m*b*e*r*”, as shown below:

Save the license in the default location suggested by the ’cmd’.

Finally, add the Gurobi package in your Julia code by writing : ‘add Gurobi’ (as any of the other mentioned packages).

*OPTIONAL

[Fig.14]
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Each of the folders comprising OptiPlant includes the following:

BASE: It includes two subfolders named ‘Data’ and ‘Results’. Includes all the elements that are not ’code-related’.

Data: Includes two subfolders named ‘Inputs’ and ‘Profiles’.

• Inputs: This folder contains different excel sheets where one can check and modify the input data for different study-case scenarios

such as: units conforming for the PtX plant, their techno-economic information, the operation strategy of the plant,etc. More details

on the ‘Inputs excel sheets’ -here-.

• Profiles: This folder contains the excel sheets where one can check and modify the wind/solar profiles and the electricity prices of

different locations during different years. More details on the ‘Profiles excel sheets’ -here-.

Results: Has the results/outputs of the simulation. A new folder will be created any time a simulation is run, and its name would

…………….correspond to the one written in the ‘Inputs excel sheet’. Includes different subfolders: Data used, Hourly results and Main results.

…………….More details on how to process and interpret the results -here-.
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RUN CODE: It includes three Julia scripts named ImportData.jl, ImportScenarios.jl, and Main.jl.

• ImportData.jl: Imports into Julia the necessary input data to run the simulation such as: PtX plant units, their techno-economic

characteristics, power profiles. . .

• ImportScenarios.jl: Imports into Julia the necessary information regarding the scenario in which the plant operates in the study.

• Main.jl: This is the optimization model per se. Uses the data imported from ImportData.jl, ImportScenarios.jl and extracts some

results/outputs of the optimization model. More details on how to run the Main.jl script in section C.
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Once the OptiPlant-master ZIP file has been downloaded -as shown in slide 3-, one will find the following folders inside:

Note: The downloaded OptiPlant-master ZIP may also include other files like the README.md, the installation and user guides, etc. These

elements are not part of the OptiPlant tool per se, that’s why they are not included in the figure above.
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[Fig.15]
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The ‘CODE’ folder is one of the two main folders in OptiPlant tool -together with the ’BASE’ folder-. This folder is simpler than the ’BASE’ one

as it only includes 3 Julia code files inside:
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[Fig.35]

The main purpose of each of the Julia scripts has been previously described (sl.9). In most cases, one will only need to modify and run the

‘Main.jl’ file, as the other files act just as a bridge to import the date form the ‘Input’ excel files.



To run the OptiPlant model under standard operation, one should only check/edit two parameters in the ‘Main.jl’ code:

• The solver being used (line 4): Either “HiGHS” or “Gurobi” (you can customize the code to use your own solver)

• The directories in which the OptiPlant tool is stored in the PC and the folders from which the input data should be taken from (lines 22-

…..25):
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[Fig.37]

[Fig.36]

*Folder name inside the ‘Results’ 
where the outputs will be saved

*OptiPlant 
directory

*Input data-excel file name

*Input data-excel sheet name
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One of the main folders of the OptiPlant tool is the ‘Data’ folder. As it can be seen in [Fig.3], it is contained in the mother folder ‘BASE’. At the

same time, it includes the subfolders ’Inputs’ and ’Profiles’
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‘Inputs’ subfolder:

The ‘Inputs’ folder of the OptiPlant tool can be found at BASE > Data. Inside the folder, it looks like something like this:

If we enter one of these files, for instance Input_data_example, we find an excel document that has the following sheets:

[Fig.16]

[Fig.17]



The purpose for each of the different sheets in any ‘Data’ excel file [Fig.5] is described below:

Data_base_case: This sheet includes a list of the different units that can constitute the PtX plant and their characteristics:

…....production rates, heat and electrical flows, load ranges, ramp up/down times, CapEx and OpEx, etc…
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[Fig.18]*

…

…



*Note on [Fig.18]: A lot of information is displayed in the Data_base_case excel sheet and can be overwhelming at first. However, it is quite

simple to read once you start getting used to it, every unit parameter has their units and source stated. One would not usually change anything

on this sheet.

The red box in -Fig.18- shows the default yearly demands of each fuel. As previously mentioned, these values are the main drivers of the

model, meaning that the model would minimize the fuel production costs of the PtX plant as long as the yearly fuel demand is fulfilled.

It is important to note that the different units are divided in ’non-electrical’ and ’electrical’.
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• Selected_units: This sheet contains a list of the different units and technologies that can constitute the PtX plant and the ones that are

..used for each fuel production process -i.e. NH3, H2, MeOH, etc.- For each case, a 1 implies that the unit is considered in the PtX plant and

..a 0 implies that it is not.
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[Fig.19] *

…

…



*Note on [Fig.19]: One can change the 1/0 values according to their preferences. However, it is important to be aware that the default values

are the ’standard case’ ones.

Note down which values you change or work on a copy-file in order to be able to go back to the ’standard case’ settings.

DTU - Department of Technology, Management and Economics 38



• Scenarios_definition: This sheet is used to define different scenarios considering factors such as the operation strategy of the plant,

..different operating constrains/conditions of the units,etc. It acts between a ‘switch’ between the Data_base_case, the Selected_units and

..the output of the model.
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[Fig.20]*

…

…



*Note on [Fig.20]: The logic of these cells is situated in between the inputs (1/0) made in the Selected_units sheet and the final output. So all

the changes made in this sheet are made compared to the input data sheet (i.e Data_base_case and Selected_units).

This sheet is especially useful when one wants to do sensitivity analysis.
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• ScenariosToRun: These sheet is used to list the different scenarios to be run through the optimization model. The conditions and

..characteristics of each of the listed scenarios make reference to the other sheets in the same excel document. One can set the scenario

..parameters such as: operating strategy, location wind/solar data, year data, produced fuel, electrolyzer technology, etc. The output results

..of the model are going to be stored as CSV files in Results > Results folder name (the folder is automatically created)
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[Fig.21]*

…

…



*Note on [Fig.21]: Be especially cautious on writing the name for the different cell’s inputs correctly in this sheet, as these ’names’ need to call

the other sheets in the same excel document.

It is also possible to create a new sheet for each study case where you define the scenarios to run through the model. If you do that, though,

be aware that the name of this excel sheet will be called in the code Main.jl (line 28), so be sure it is correctly called/changed in this code line

too.
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• Sources: These sheets include the references and sources of the data used in the sheet Data_base_case. In principle, one would not need

…to edit the content of these sheets when running optimization of scenarios.

• …Good practice is that if a user changes/adds some input data displayed in the Data_base_case sheet, he/she also updates the source

…where this information was taken from in this sheet.
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[Fig.22]

…

…



As previously mentioned, the ‘Data’ folder is one of the most important elements of the OptiPlant tool. As it can be seen in [Fig.3], it is

contained in the mother folder ‘BASE’. It contains the subfolders ’Inputs’ and ’Profiles’
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‘Profiles’ subfolder:

The ‘Profiles’ folder of the OptiPlant tool can be found at BASE > Data. Inside this folder, it looks like something like this:

If we enter the 2019 file, we find an excel document that has only two sheets:

[Fig.24]

[Fig.23]



The purpose for each of the different sheets in any ‘Data>Profiles’ excel file [Fig.12] is described below:

• Flux: This sheet contains the hourly solar and wind profiles for the year ’2019’ using different solar and wind technologies in different 

..locations. 
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[Fig.25] *

…

…



*Note on [Fig.13]: Take into account that the numbers in the ‘Flux’ excel sheet represent the normalized output power for each generator.

The solar/wind power profiles included in the Flux excel sheet are extracted from the CorRES tool (for wind profiles), and from

renewable.ninja website (for solar profiles).
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• Price: This sheet contains the hourly electricity grid buy price for the year ’2019’ at different locations. 
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[Fig.26]

…

…
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One of the main folders of the OptiPlant tool is the ‘Results’ folder. It is contained in the mother folder ‘BASE’ and it has the following files and

subfolders inside:

Each of the folders corresponds to one simulation run, and as stated before, its name is settled inside the ’ScenariosToRun’ excel sheet from 

the ‘Inputs’ file. Each of these folders -e.g. ’Results_base_case’ - includes three subfolders named ’Data used’, ’Hourly results’, and ’Main 

results’, that include the inputs and results of the simulation in CSV files, respectively:
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[Fig.27]

[Fig.28]



To process and read the CSV results included in the folders shown above, it is recommended to create a copy of the ‘Results’ excel file that can

be found in the ‘Results’ folder -see [Fig.15]- and save it in the corresponding ’Results ***’ subfolder, like shown below:

When opening any of the ‘Results’ excel file (or one of its copies) one would find a document with the following sheets:
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[Fig.29]

[Fig.30]



First off, to check the results of the corresponding simulations, open the corresponding ’Results’ excel file and import the data by going to the

‘Import’ excel sheet, writing the right CSV files directory and clicking on the macros:

Note: Make sure the directories for the ‘Main results folder ‘ and the ‘Hourly results folder ‘ are written correctly and end with ‘\’
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[Fig.31]

…

…



Once the results are imported, one would be able to see the outcomes and results for the different studied scenarios individually in the

different excel sheets. Each scenario will be named as it was in the ‘Inputs’ excel file.

For instance, in the ‘All_scenarios’ sheet, one can see all the output values for each unit and scenario:
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[Fig.32]

…

…



In the other excel sheets such as ‘Elec production’, ‘Electricity consumption’, ‘Production cost’, ‘Cost breakdown’ and ‘Installed capacities’,

one can see a break down of the output values of each unit and scenario and plot simply the results by using ‘Pivot Tables’. For instance:

Remember to refresh the pivot table every time you import new results
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[Fig.33]

…

…



Furthermore, one would see that some new excel sheets appear when importing the ‘hourly results’. Each of the new excel sheets corresponds

to one of the run scenarios, and the hourly flows for different parameters is displayed. As an example:
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[Fig.34]
…

…



Note on the ‘Results’ units: It is important to mention that the UNITS for the outcomes and results (if not specified) are in tonnes per hour

(t/h) for the ’non-electrical’ units and in megawatts (MW) for the ’electrical’ ones. The units corresponding to the results shown in the hourly

flows are x/1000 (i.e. kg per hour and kilowatt, respectively). The units for mass storages (i.e. hydrogen tank) are in tonnes (t) and the units for

electricity storage (i.e. batteries) are in megawatthours (MWh).
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Hopefully, this user guide was clear and useful for the reader.

In case the user encounters errors during the installation of the software, the author suggests to check the official installation guides for each

program. On the other hand, for some issues related to the OptiPlant tool use, the author suggests to check the next section of this document

called ‘troubleshooting’, where one can find some of the most common errors that may appear when using this tool (and how to solve them).

When encountered with other errors not mentioned in the ‘troubleshooting’ section, use internet forums or other tools (such as AI) to try to

tackle them.

In last resort you may contact one of the author of the model.

Have fun using OptiPlant! 
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The purpose of this section is to list and offer a solution for some of the most typical errors one can encounter when running the OptiPlant tool

for the first time. This part of the document is though to be edited and upgraded by the different users using the tool. The three main ERRORS

tackled in this section are listed below:

1) ERROR: Package X not found

2) ERROR: File not found ’not such file or directory’

3) ERROR: Format error when displaying the simulation results in excel
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The purpose of this section is to list and offer a solution for some of the most typical errors one can encounter when running the OptiPlant tool

for the first time. This part of the document is though to be edited and upgraded by the different users using the tool.

1) ERROR: Package X not found

If this message appears, you probably haven’t activated the environment before running a code. The environment includes

all the packages installed necessary to run the code successfully. To solve it, activate the environment:

Enter the ’package manager’ by pressing ’]’ and write ’activate env’ on the package manager. If the error still appears, check that the package

you need to use is correctly installed by writing ’status’ on the package manager -after activating the environment-. If it does NOT appear

there, it means the package is not installed. You can install it by writing: ’add ***’ (***= name of the package) in the ’env’ option. Another

reason this error may appear is that you are not calling the package X at the beginning of the code. To solve it, call the necessary packages. It is

done like this:

[Fig.38]

[Fig.39]
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2) ERROR: File not found ’not such file or directory’

If this message appears, you probably haven’t routed the different Julia scripts and excel sheets correctly to the optimization

code ’Main.jl’. To solve it, make sure that you are routing all the files correctly. For instance:

Pay extra attention to the routes when having numerous folders and subfolders!

[Fig.40]

[Fig.41]
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3) ERROR: Format error when displaying the simulation results in excel

Once the model has run successfully and some results have been generated, one can encounter some problems when reading the CSV ’results’

file. For instance, when importing the ’main results’ CSV, one can get ’weird/unrealistic’ results if the importing method is not defined

correctly:

[Fig.42]
…

…
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… 3) ERROR: Format error when displaying the simulation results in excel

It can be clearly seen that the obtained results for the installed capacities are too large. There might be an error on the CSV reading process. To 

check that the error is in the file lecture and not actually in the results, we open any of the CSV files on ’Main results’ with the notebook. One 

should see the following:

The numbers here are realistic and a priori seem correct. Observe that the CSV file separates cells with commas and decimals with dots. To 
make our excel file read the file and use the separators correctly we do the following:

1. Inside excel, go to File > Options > Advanced and look for this lines here:

[Fig.43]

[Fig.44]

The decimal separator should be a dot (.).
If possible, set the thousands separator to
’none’ or just add any symbol which is not
a dot (.), for instance an apostrophe (’).
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… 3) ERROR: Format error when displaying the simulation results in excel

2. Go to HOME and click in the ‘Number’ tab -bottom corner right of the image-:

3. Untick the ‘Use 1000 separator’ box:

[Fig.45]

[Fig.46]
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… 3) ERROR: Format error when displaying the simulation results in excel

After completing the previous steps, reset Excel and import the data again. It should look like this now:

[Fig.47]

…

…


